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Introduction 
Thank you for choosing SMART Estimator. 

SMART Estimator BIM Toolbox is a set of tools for using existing 2D and 3D data from your client and 
sending information back to them in the same form. 

You can use an existing 2D site plan to help visualise and estimate scaffolding more easily. 

 
3D models can be sent to other BIM software, such as Revit, SCIA Engineer, AutoCAD Architecture and 
many more, using the universal IFC file type. 
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Create a new project 

 
When you first launch the application, you will see the New screen.  You can also open this screen by 
pressing the File menu button and selecting the New option. 

To create a new project, press New Enterprise Server Project. 

 

New Enterprise Server Project (Recommended) New Project 

 
This option unlocks additional functionality later.  
Using this option is recommended. 

 
Use this option only if the server is not available, or 
if you are testing. 

 

You are given a chance to select the Customer Address and Site Address for this new project.  It is 
recommended that you enter the Customer Address now, if you know it.  This will appear on the 
quotation (if you have Quote IT).  If you know the Site Address please enter it now as well.  This will 
be used for pricing transport, importing a site satellite photo and for the TG20 check (if you have Price 
IT, BIM Toolbox or Check IT TG20:13). 

 
Press Create Project to create the project file. 

If you entered a new address, you will be asked if you want to save it. 

Please read the Getting Started Guide first.  It will help you customise SMART Estimator before 
continuing to read this guide. 
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Trace around a site plan 
This section will demonstrate how to make use of an existing site plan for visualisation and estimating. 

Bring in the site plan 
To trace around a site plan, you must first import the plan.  Usually this is received from your client as 
an Adobe PDF or AutoCAD file.  If you don’t have these, or if you prefer a site photo, SMART Estimator 
can import a satellite photo of the site from Google Maps©. 

The three import methods available are: 

 1. Bring in the site plan as traceable lines (recommended) 

 2. Bring in the site plan as an image 

 3. Bring in a site satellite photo 

1. Bring in the site plan as traceable lines (recommended) 
Site plans can be added to SMART Estimator from an existing file.  The following types of file can be 
used: 

 Adobe (vector) PDF 

 AutoCAD DXF 

 AutoCAD DWG 

 

2. Bring in the site plan as an image 
Where possible, we recommend bringing in a site plan as traceable lines.  This is usually more useful, 
as specifying the scaffolds is easier.  Where this is not possible, you can bring the site plan in as an 
image instead.  The following types of file can be used: 

 Adobe PDF 

One site plan can be added for every item in the project.  If you have a single project across multiple 
sites, or if the site is divided up into sections, one site plan can be added for each. 

 

Please note that only vector PDF files, such as those created through design software (for 
example, Revit) are supported.  Regular raster PDF files will not import. 
Any PDF created by scanning an image or document using a standard scanner will be a 
raster PDF. 



 BIM Toolbox user guide 

 
 
   

 
4    Copyright 2018 © Computer and Design Services Limited 

How do I check if my PDF is vector or raster? 
There are two simple ways to check if a PDF is raster (not importable into SMART Estimator) or vector 
(compatible with BIM Toolbox): 
 

1. Zoom in 
 
Using your preferred PDF viewer, zoom in on the PDF by the maximum amount.  If graphics 
still appear perfectly smooth, it is a vector PDF.  If they become distorted (‘pixelated’), it is a 
raster PDF. 

 
 

2. Select the graphic 
 
If your preferred PDF viewer does not have vector editing tools (e.g. Adobe PDF Viewer), 
clicking on a vector graphic will not cause anything to be highlighted. 
Clicking on a raster graphic, however, selects the entire graphic: 

 

Vector PDF graphic 
BIM Toolbox will import this graphic. 

Raster PDF graphic 
This PDF will not import correctly. 

After zooming in 

Vector PDF graphic 
BIM Toolbox will import this graphic. 

Raster PDF graphic 
This PDF will not import correctly. 
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Can I convert my raster PDF into a vector PDF? 
There are a large number of tools available for converting raster PDFs to vector PDFs, such as those 
offered by Print2CAD. CADS do not offer or endorse any such tools, but your business may find that 
an existing tool suits your needs. 

Bringing in the site plan from a file 
To add a site plan, select the Background menu: 

 
 

From this menu, select the Import or Import PDF as Image option: 
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You will be asked to select a site plan file.  Do this and the site plan will be added to SMART Estimator. 

 

 

Once the site plan has been added, it is a good idea to check that the scale is correct. 
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Nothing was imported.  What went wrong? 
If an error message was displayed, please read the message and act accordingly.  The import file may 
be corrupt or an incompatible version for example. 
 
If no error message was shown, but there is no site plan shown, the following issues may be the cause: 

 The site plan may be off-centre; 

If you received an AutoCAD file where all objects are away from the origin by a large amount, 
they may be imported outside SMART Estimator’s active area. 

Any objects close to 750m from the origin may not be visible in SMART Estimator. 

Try moving objects closer to the origin and then importing. 

 The scale is incorrect; 

SMART Estimator’s scale is in metres.  If the source file scale is unclear or incorrect, some (or 
all) objects may appear outside SMART Estimator’s active area. 

Try setting the scale in the source file and check the size of objects before importing. 

 There are too many objects in the site plan; 

BIM Toolbox imports objects from the site plan in the order they are read from the file until it 
reaches a (very large) maximum.  This includes non-line objects. 

If there are a great many layers or objects, some objects may not be imported.  It is possible 
that no line objects are imported at all. 

Try removing layers from the source file or reducing the number of objects before importing. 

 The site plan is not on the first page of a source PDF; 

BIM Toolbox only imports the first page of a PDF.  Any objects on subsequent pages are 
ignored. 

Try moving the site plan to the first page of a PDF before importing. 

 

 

Once the site plan has been added, it is a good idea to check that the scale is correct. 
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3. Bring in a site satellite photo (requires internet) 
It is possible to import a site satellite photo from Google Maps©.  This requires an internet connection. 
  
To do this, first select the Satellite Photo menu: 

 
 
Ensure the Site Address is filled out with a valid postcode.  You can set this by selecting the Site 
Address button: 
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Fill out the site address, and press the green tick button to apply your changes: 

 
Finally, select the Import Site Satellite Photo button of your choice to import a satellite photo of the 
site. 

 
 

 

Choosing a smaller size will give a higher quality image.  Try the smallest size first. 
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Set the scale 
To set the scale for the site plan, you will need to know one of the dimensions for something in the 
site plan.  Knowing the length of one elevation or object, select the Scale menu.  This is available from 
the Background drop-down menu. 

 
Select the Scale by Length option.  

 
 

 

If you imported the site plan as an image, you can only scale the image border. 
To scale by lines in the site plan, you must import as a set of traceable lines. 
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Then use the tool to select both ends of a line and set its length: 

 
The whole site plan will be set to use the new scale. 

Select the end of an elevation or line. 

Select the other end of the line. 
elevation or line. 

Type the correct length and press Enter. 
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Move the site plan 
If you don’t like the positioning of the site plan, you can move it using the Drag the background option 
from the Move menu on the Background drop-down menu. 

 
Note that you can only drag either horizontally or vertically.  To drag diagonally, you must drag in two 
separate actions. 

 
To move the plan back to its original position, select Move the background to the centre, from the 
same menu. 
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Filter the site plan 
Some site plans contain information that you don’t need.  Removing such useless information from 
the plan may make it easier to use and understand.  There are two ways to filter this information out 
of the plan: 

 Remove selected colours from the plan; 

 Remove selected layers from the plan. 

Remove selected colours from the plan 
You can remove a selected colour from the plan.  For instance, your plan may include engineering 
mark-up that is not required for estimating a scaffold around the outside of the building: 

 

Remove selected layers from the plan 
If the file you used as a site plan includes the objects grouped into layers, you can remove unnecessary 
layers from the plan: 
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To remove selected colours or layers from the plan, follow these steps: 

 

Select the Filter menu from the Background 
menu on the BIM Toolbox tab. 

Choose whether you would like to select colours or 
layers to remove from the plan.  Changing this 
option will reset any existing filter. 

Deselect tick boxes to remove that colour or layer 
from the plan.  Select a tick box to add that colour 
or layer again. 
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Trace around the site plan 
Once the site plan is scaled and filtered to show the correct details at the correct size, it is ready to be 
used as an estimating tool. 

 

 
To trace around the site plan, click on Draw Plan. 

 
You will be shown the site from above: 

 
A grid of clickable blue points is available, so you can create any shape of scaffold required. 

You don’t need to use the blue grid of points, since you are going to trace around the building on the 
plan, so the first task is to hide it. 

If you imported the site plan as an image, you can only trace using the grid. 
To trace lines in the site plan, you must import as a set of traceable lines. 
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Hide the grid of points 
To hide the grid of points, choose the Hide Grid button. 

 

Trace around the building 
To trace around a building, simply click the points around the edge of the building to create 
independent scaffolding: 

 

Close the building 
To make the scaffolding continuous, the final point on the building must exactly match with the first 
point you selected.  Since this can be difficult to select, please use the Close the building option: 

 

As you move the mouse close to the end of a line, 
or the intersection between two lines: a small, red, 
selectable point appears. 
Click on these to create your scaffolding. 
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Trace around another building 
To create a new independent scaffold, rather than continuing an existing one, select the Draw New 
Independent button. 

 
Trace around all of the buildings you wish to estimate in this item: 

 
To find out more about using Draw Plan and creating scaffolding in 3D, please see the SMART 
Estimator Model IT User Guide. 

Clear the Site Plan 
To remove the site plan, choose the Clear option.  This is available from the Background menu on the 
BIM Toolbox tab. 
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Send a 3D model to other BIM software 
To create a 3D model which can be used in other BIM software, for visualisation, design or planning, 
the universal IFC file type has been provided. 

To create an IFC file of your scaffolding, select the Create IFC button on the BIM Toolbox tab. 

 
You will be asked where you would like to save your IFC file: 

 
Select a location and name for your IFC file and press Save. 

Many software packages include the ability to add IFC models.  If you, your client or engineers have a 
3D model of the structure you will be scaffolding around, you can show the scaffold and the structure 
in the same model.  You or your client could use this information for planning or visualisation. 

The IFC file does not contain all of the information used by SMART Estimator, so you should still save 
your project by pressing File and then choosing the Save option. 
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Add images to the building elevations 
You can add images to the front face of any modelled building elevations.  For example, you could add 
photos of the building or your company logo. 

To do this, select the Add Elevation Image button: 

 
Using this tool, click on the elevations that you wish to add an image to: 

 

 

Hold the Ctrl key as you click on an elevation to add this image to only one elevation.   
If you don’t hold the Ctrl key, the image will be added to all elevations of this scaffold. 
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You will be asked to select an image file.  Do this and the image will be added to the front of the 
elevation. 
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Edit the site plan or elevation image 
Once you have imported a site plan as described in the Trace around a site plan section, or added an 
elevation image as described in the Add images to the building elevations section, you can edit it to 
add mark-up or remove unwanted details. 

 For elevation images, select the Edit Elevation Image button. 

 
Using this tool click on the elevation with the image you want to edit. 

 
  For site plans, select the Edit Background Image button. 
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An editor will open so you can make changes to the image. 

 
 

The following tools are available: 

 
 Undo 

Undo the previous change to the image. 
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 Pen 

Draw on the image with the mouse in your choice of colour and pen size. 

 
 Crop 

Remove unwanted portions of the image.  To do this, select the tool, then drag the edge and 
corner grips to remove the parts of the image you don’t want, and press Apply: 
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Using the other SMART Estimator products 
The best way to use the SMART Estimator products is to use them together.  Every product is designed 
to enhance the rest of the suite. 

SMART Estimator BIM Toolbox can be used with the rest of the SMART Estimator products: 

Model IT 
SMART Estimator Model IT is a powerful 3D modelling tool. Use it to create scaffolds to exactly meet 
your project-specific needs.  It is recommended that Model IT is used alongside BIM Toolbox, since 
you can use it to trace around a site plan.  

Schedule IT 
As a fast way of creating large, multi-scaffold projects, Schedule IT can be used to rapidly create 
scaffolding projects.  It provides the ability to copy and paste scaffolds, enabling faster scaffold 
modelling. 

Report IT 
Produce material lists and technical drawings alongside the 3D IFC model. 

Price IT 
Produce a fast and highly customisable pricing report for your scaffolding project. 

Quote IT 
Generate quotations for the project, to send to the customer. 

Check IT TG20:13 
Check your tube and fitting scaffolds against TG20:13 to prove that a bespoke design is not required. 

 

For more information about the other SMART Estimator products, please refer to 
their user guides, which are available from the Help tab. 
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Feedback 
Thank you for choosing SMART Estimator. 

We are always striving to improve the product so please contact us with your feedback. We are always 
keen to hear new ideas and if you experience any problems with the software we want to hear about 
them so that they can be resolved. 

 
 

 

 

You can contact us via: 

 Our website support centre at www.smartscaffolder.com/support.html; 

 Email on support@smartscaffolder.com; 

 Telephone on +44 (0)1202 603733 from Monday to Friday between 09:30 and 17:00. 

 


